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intel)

Introduction

1.1

Bring Up Guide

This document covers the future Intel® Pentium® processor or future Intel® Celeron®

processor N- & J- series based platform (formerly Bay Trail-M/D platform) firmware
bring-up procedure for Intel® quad-core technology SoC (B2 silicon).

The bring-up procedure primarily involves building a FW image. Once the FW image is
built, it can be programmed to the Bay Trail platform. All the paths mentioned in this
guide are relative path to the root of the given Kkit.

Please note: Some of the chapters in this document are relevant for Android
projects only (Chapter 7, Appendix A, and Appendix B)

Terminology
Term Description
FITC Flash Image Tool Creation
FPT Flash Programming Tool
Intel® TXE Intel® Trusted Execution Engine (Intel® TXE)
Intel® TXEI Intel® Trusted Execution Engine Interface (Intel® TXEI)
ADB Android* Debug Bridge

Intel Confidential



i n te l ® > Quick Start Check-List

2 Quick Start Check-List

2.1 First Boot of Bay Trail-M/D

To run first basic boot of the Bay Trail-M/D platform, ensure to have the following:

e Build the SPI FW image
— Build the image using FITC tool as described in section 3.4 and flash the image
components from the FW kit

e Flash the SPI FW image
— Flash using Dediprog or FPT method as described in section Flashing Target3.6

o If using Windows OS: Install Intel® Trusted Execution Engine Interface (Intel®
TXEI) Driver as described in section 8
— Once the platform boots, install the Intel TXEI driver found in the FW Kit

e Verify Intel® Trusted Execution Engine (Intel® TXE) information
— Run TXEInfo tool found in the FW kit "\System Tools\ TXEInfo\"” directory

o Verify Intel TXE status via TXEManuf tool
— Run TXEManuf tool found in the FW kit “\System Tools\ TXEManuf\” directory
— Use TXEManuf.cfg to enable/disable tests of interest

For more details on each of these steps, please refer to the appropriate
chapter within the Intel TXE FW Bring up Guide.

§
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3 Procedure

3.1 Prerequisites
o fitc.exe: can be found under \\System tools\Flash_Image_Tool folder
e DediProg SF100

e FPT can be found under \\System tools\Flash_Programming_Tool

3.2 Start FITC

e Invoke Flash Image Tool by navigating to \\System tools\Flash_Image_Tool folder

e Double click fitc.exe.

3.3 Set Up Build Environment
In the main menu select Build> Environment Variables.

Figure 1. Enviroment Variables

File | Build | Help
D Build Image 75 | ~[intel (R) Z2oox ~|
EE| Environment Variables... ! Parameter I Value
5 Build Settings...

(Z2 Compenent Section
(£ Master Access Section
(L0 50C Straps

[C Upper Map

+-[[0 VSCC Table

Edit your configuration as shown below.

e $Source Dir: The location where FITC will look for binary images during the image
creation process

e $DestDir: The location where FITC will save the binary image
e $WorkingDir: The location where FITC.exe is running. Please keep it as *.”

Bring Up Guide Intel Confidential
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Figure 2. Environment Variables

Environment Variables | —)

Current working [E4g5utrail1.0.0.7038WLVAT ools\Sec_T ools\DC\System_T ools
directory |\Flash Image_Tool

$CuworkDir : ]C:\B aytrailh1.0.0.7038 |

$workingDir: |- =]

$SourceDir : ]C:\Baylrail\l.0.0.7038\Images\VLV\Si\DC\VLV_SOC_IA32_R_0009_ |

$DestDir : [C:\Baytrail1.0.0.7038\Images\WLVASADCWLY_SOC_IA32_R_0009, [ .. |

$Usearl : |. _]
$Usevar2: |. _I
$Usevar3: |. _I

ok | cancel |

Figure 3. FITC Set Up

[~ Buid

Output path: |$D estDiroutimage.bin . I

[V Generate intermediate build files
[ Build compact image (ignores the flash component sizes in the descriptor).
r Do not set End of Manufacturing bit when BIOS M aster access regions

are get to Intel Recommended zetting.

Mote: Once an image iz built with End of Manufactuing bit get, it cannot
be unzet or changed by decompasing an existing image in the taol. Itis
necessary ta build a new image in order to have this bit unzet.

Flash Block/Sector Erase Size: |4KE j

Fic Fl.
Fl

"
lash

Upper Flash Block/Sectar Erase Size: |4RB >
Lower Flash Block/Sectar Erase Size: |4KE -
Flash Parlition Boundary Address; |0400001000

Cancel

Note: Please use the environment variables when defining output path in Build - Build
Settings, as shown

10 Intel Confidential Bring Up Guide
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3.4 Create Flash Image

3.4.1 Using GUI

1. Run fitc.exe.
2. Define output image name and path
3. Build &> Build Settings > Output path

Figure 4. Define Output Path

Dutput path: |$DestDirkoutimage bir

[ Generate intermediate buid files
I~ Buld compact image (ignores the flash component sizes in the descrptor]
[~ Danat et End of Manufastuing bt when BIDS Master access regions

ate set o Intel Recommended setting

Mote: Once an image is built with End of Manufactuing bit set, it cannot
be unset or changed by decomposing an existing image in the tool. Itis
necessary bo build a new image in order to have this bit unset,

Flash Block/Sector Erate Size: |4KB -

Upper Flash Block/Seotor Erase 5= [#B <]
Lower Flssh Block/Sector Evsse Size: [0 B
Flash Pariion Bounday fdress: [0-00001000

Cancel

4. Select platform type
a. On the platform selection list, select Bay Trail - Notebook or Bay Trail -
Desktop before modifying and building the flash image.

SOC straps definition will be changed upon Platform selection.

Figure 5. Select Platform Type

File Build Help
D& ﬂ Intel (R) Bay Trail - Desktop LI
{423 Flash ImageIntel (R) Bay Trail - Tablet meter
5-£3 Descript/Intel (R) Ba Tul - Notebook
3 Des lqte_! (R).B_ay Trail - Desktop
(2 Component Section
@#-(C Master Access Section
@ SOC Straps
2 Upper Map
@ VSCC Table
3 OEM Section
%) PDR Region
(20 GbE Region
(] TXE Region
(23 BIOS Region

Bring Up Guide Intel Confidential
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5. Fill in Intel TXE Region:
a. Select "TXE Region” and double click “TXE Binary Input File”

b. Select \\Image Components\TXE\. .\*.bin

Please note: Steps 6-7 are relevant for Widevine feature only.
6. Construct FITC_CEK.bin following chapter 15: Appendix instructions
7. Add FITC_CEK.bin file (Flash Image -> TXE Region -> Configuration -> TXE ->

CEK Configuration)

Figure 6. Add FITC_CEK

Build Help

Eile
OD=E | IﬁﬁllBayTrail - Notebook

=l

=424 Flash Image
511 Descriptor Region
[%) PDR Region
|23 THE Region
= Cenfiguration
L0 TXE
[Z0 Features Supported
: (0 Intel (R) NFC Capabilities

FPF Mirroring File

Pararneter Value Help Text

FW Update OEM ID 00000000-0000-0000-0000-000000000000 Enter UUID or file contait
Host TXE Region Flash ... true Set this to TRUE if you w
OEM Tag (000000000 An OEM identification mi
Hide FW Update Control  false Setting this parameter to

CEK Configuration | |Binaryfileto use for CEK]

Enter a path to the FPF rr

Figure 7. Intel® TXE Region

b s

g

=

=423 Flash Image
(123 Descriptor Region
(| Descriptor Map
-[Z1 Component Section
-0 Master Access Section
(L SOC Straps
-[(1 Upper Map
3 VSCC Table

----- [} POR Region

Parameter

Value

TXE Binary Input File

[C GbE Region
(Z TXE Region
[Z BIOS Region

Ll

Cancel |

o]

8.

Fill in BIOS Region:

a.
b.

12

Select "BIOS Region” and double click "BIOS binary input file”
Load BIOS image (*.ROM)
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Figure 8. BIOS Region

O & B | ¥ |intel (R) Atom Series Chipset v | Intel (R) Zoox

E

=3 Flash Image
123 Descriptor Regien
..... [ Descriptor Map
----- [ Component Section
(-1 Master Access Section
-3 SOC Straps
..... [ Upper Map
B[] VSCC Table
----- [ OEM Section
----- [X] POR Region
----- [Z1 GbE Region
----- [Z1 TXE Region
----- [Z1 BIOS Region

Parameter

I Value

BIOS region length
BIOS binary input file

(000000000

BIOS binary input file

Thiz iz the BIOS image binary that will be copied into this region.

0K

Cancel |

9. Configure SPI Flash image size
a. Select Flash Image/ Component Section/ Flash component 1 density
b. Configure the size of the SPI Flash image (e.g. 8MB, 4MB)

c. Save XML

Figure 9. Configure Flash Image Size

Bring Up Guide

55

File Build Help

Untitled.xml - Flash Image Tool 1.0.2.1067

.Y

D=z E | mlBayTrail - Notebook

El

=3 Flash Image
21423 Descriptor Region
.. [[] Descriptor Map
-1 Compenent Section
#-- (L0 Master Access Section
(2 SOC Straps
-2 Upper Map
-] VSCC Table
-] OEM Section
----- [X} PDR Region
- [C1 TXE Region

Parameter Value Help T
Read ID and Read Status clock frequency  30MHz If more
Write and erase clock frequency 50MHz If more
Fast read clock frequency 50MHz This fie
Fast read support true Enable:
Read clock frequency 20MHz Sets th
Flash component 2 density 8MB This fie
[Flash component Tdensity ______Jams | Thisfig
Dual Qutput Fast Read Support false false: b
Invalid Instruction 3 0 Op-cot
Invalid Instruction 2 0 Op-cot
Invalid Instruction 1 0 Op-cot

Intel Confidential
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10. Build image

Figure 10. Build Image

Procedure

File

Build | Help

Build Image

F5 || ~]intel (R) oo -

Environment Variables...

Build Settings...

Parameter I Value

-0 SOC Straps

1 Compenent Section
-2 Master Access Section

Note: A warning will appear when building the image, Click “Yes”.

Figure 11. Warning Message

o

The region "GbE Region” has a length of 0 and ne binary file was
specified! This region will be disabled in the final image.
Are you sure you want to continue with the build?

The output image will be located at the path given at step 3.4.1

Figure 12. Image Output

device2

<2, . 1%, v

Vendorld = OXEF, Deviceld0 = 0x40, Deviceldl = 0x16, VaccValue = 0x20052005

winbond

Vendorld = OxEF, Deviceld0 = 0x30, Deviceldl = 0x16, VsccValue = 0x20052005

Nucmonyx

Vendorld = 0x20, Deviceld0 = 0x20, Deviceldl = 0x16, VsccValue = 0x20052005

Winbond W25Q64BV

Vendorld = OxEF, Deviceld0 = 0x40, Deviceldl = 0x17, VaccValue = 0x20052005

AT25DFé4

VendorId = Ox1F, Deviceld0 = 0x48, Deviceldl = 0x00, VsccValue = 0x20152015

Upper Map

IXE Region: “C:\Baytrail\l.0.0.7038\VLV\ImageComponents\SEC\DC\SI\REL\VLV_SEC_REGION.bin®

BIOS Regicn: "C:\Baytrailll.0.0.7038\VIV\ImageComponents\BIOS\EDK\VLV_SOC_IA32 R_0009_10.ROM"

Nricin
Nriting MAP file *.

ROM image file “".\outimage.bin".

Image size = Ox800000 bytes

-~ done --

14
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3.4.2

3.5

3.5.1

intel)

Using Command Line
Please use the command line to create image through command line:

fitc.exe newfiletmpl.xml -b -txe PRODUCTION_TXE_Region.bin -bios
BIOS_Region.ROM

- Please note, if the Intel TXE Region or BIOS region not at the same directory as
FITC tool you will need to mention the path

XML Configuration

Save Your Settings

11. When opening FITC.exe, it loads defaults settings defined in newfiletmpl.xml
(located in the same folder as FITC.exe)

Figure 13. FITC Configuration

Bring Up Guide

Name Uate moditied lype
L Int 8/29/2012 15:29 File folder
fitc.exe 8/22/2012 10:15 Application
o | fitc.ani 10/3/2012 15:46 Configuratior
. fitc.log 10/3/2012 16:05 Text Docume
= fitctmplxml 8/22/2012 10:09 XML Docume
1‘_3? fitcwizardhelp.chm 8/22/2012 10:09 Compiled HT
[»-_ newfiletmpl.xml | 10/3/2012 15:49 XML Docume
| outimage.bin 10/3/201213:4 BIN File
&) outimage.map 10/3/201213:43 Linker Addre:
= saveMe.xml 10/3/2012 14:08 XML Docume
| vsccommn.bin 8/22/2012 10:09 BIN File

12. To save your custom settings, in the main menu select File>Save As. Select a
name and location for the XML file that contains all the settings configured so far
It is recommended that you save this file in the same directory as FITC.exe is
located for easy access.

Intel Confidential
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Figure 14. Save Configuration

CtrieN  fies Chipset v | [intel (R) QM77 - Mobile o~
Ctrl« O Paramaeter l Value
Ctrls S

Exit Rion

) Upper Map
1 L VSCC Table
3 OfM Section
) PDOR Region
) GbE Region
) TXE Region
L) BIOS Region

Figure 15. Configuration Protection

-_— OO
ec_Tools » QC » System_Tools » Flash_Image Tool » - | *9 Search Flash_Image_Tool
- New folder

Name

o Int General | Security | Details | Previous Versions |

[E fitc.exe

newfiletmpl xaml

<& | fitc.ini <°5]
|| fitc.log

fitctmpl.xml
newfiletmpl.xml

|#| outimage.bin

Type of file: XML Document {xml)
Openswih: 52 XML Edtor

Location: C:\BayTrail\Tools“Sec_Tools"QC\System_Tools\Flz

=] outimage.map

& vsccommn.bin
Size: 54.1 KB {55.470 bytes)

Size on disk: 56.0 KB {57.344 bytes)

Created: Today. February 21, 2013, 10:05:38 AM
Modified: Tuesday. January 29, 2013, 11:38:18 AM

Accessed: Today. February 21, 2013, 10:05:38 AM

Adtributes: Read-only § [ ] Hidden Advanced...

13. Protect configuration XML file from accidental changes by checking the “Read-
only” attribute, as shown below.

3.5.2 Load FITC Configuration

Default or custom settings can be loaded by selecting File>Open in the main menu,
and navigating to the desired xml configuration file.
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Figure 16. Load Configuration

w

3.6

3.6.1

ntel.

IMew Curll=M
Open.. Ctrl+ O
Save Ctrl+5
Save Asx...

[ Upper Map
=0 VSCC Table
£ OEM Section
K} POR Regien
3 GbE Region
[ TXE Region
=3 BIOS Region

Hies Chipset

~| [intel (R) QMTT - Mobile

Exit fion

Pararneter

Flashing Target

Using DediProg

14,

Run DediProg Software

15. Click “Detect” to verify SPI flash detection

16. Please make sure the voltage is set to 1.8v by clicking Config-> Miscellaneous

settings

17. Click “File” button and select the FW image built in step 3.4.

Figure 17. Set Voltage

Bring Up Guide

Advanced Settings

Batch
Operations

|

Pragram
Configuration

Engineering
Mode

Modify Status
Register

o
L

Miscellaneous
Settings

Vpp Option:

Apply Vpp for program and erase when the memory supports it.

(CIManual adjust Ve (For SFE00 anly)

Veo Option:
Manual select Voo
Weo
(@ Using Fixed Yeo () 3.5V
O 25y
@ 1.8V
SPI Clock Setting
Select Clock:
|12tz v

Toolbar Icon Configuration:
Blank: [#]Enable Blank Button
Erase: []Enable Erase Button
Prog: Enable Prog Button
Verify: [¥]Enable Verify Button
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Figure 18. Select Image

T Oecitrog Software GOLTT e T | S TR T — T S —— E ol L]
"o  Veow  Sietp o— - )
®© @@ v B D BB
Deseet Pile Blank  Krese Prog Verity Pamh Eais Comilg of Rave Fu)
Curvorty morkeng on: W ADRC AT My CPep L AR My Chegp 3 Kdate Ltaret Ak % et
Crrverily morhirg rogon| b Regne ) Rogor 3 Raegon ) Sagon * RAmpon §

() 3033429 1M 1303

I
)
r Wekiome 10 Oediveg 6.0.3.13
H W i3ag-e tinss 5 |
o W 29 151580 —_— wevedd ¢ <
i -~ v 25 1
Y o

(0 201240039 151554 =00

() 2012 M29 1311550 208
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18. Click “Prog” to flash the flash image to the target

Figure 19. Prog Option
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19. Verify flashing was performed correctly

Figure 20. Result Expected
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3.6.2 Using FPT

1. FPT is a Windows based tool aimed to program FW on the platform (FPT is running
from the platform). Under \\System tools\Flash_Programming_Tool
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2. Copy the FW image to the root folder of the FPT tool and rename it to
outimage.bin. (For simplicity, we will use \\Flash_Programming_Tool\Windows
when referring to FPT tool directory)

3. Open command line with administrative privileges, navigate to

\\Flash_Programming_Tool\Windows or Windows64 and type:

The system should respond with the number of SPI Flash devices available. For
example:

Program the SPI Flash image to the Flash device(s) by issuing the following
command at the prompt:

—

If the programming was successful, then the following message will be shown:

Bring Up Guide Intel Confidential 19



i n te l ® > FPF Configuration File

4 FPF Configuration File

e FPF configuration file is an input to FPT, FITC, and to Manifest Generation tool.
e FPF configuration file can be found under \\System tools\FpfConfigFile.txt.

e The file contains a list of fuses, where each line describes a fuse file in the following
pattern: [ID]:[Value]:[Locked]
ID: Fuse file ID
Value: Desired value of fuse file in **hex** digits, must be byte-aligned (For
single bit file, should be 00 or 01)
Locked: Boolean indicates if the file should be locked (TRUE/FALSE).
Example: FUSE_FILE_ALT_BIOS_LIMIT:1FFF:FALSE

Table 1. Fuse Files

Name Description

Hash of the key material used by the OEM to sign the

OEM_KEY_HASH Secure Boot Manifest

Alternative BIOS limit. Used to locate the Alternative
copy of the IBB and the manifests.

This is actually thel3 MSbits of the physical address.
LSbits assumed to be OxFFF

ALT_BIOS_LIMIT

This bit indicates that SB it is enable and the other

SB_EN values where already configured

This is the ID of the of the Key Manifest

KEY_MANIFEST_ID (if 0 no Key Manifest is required)

FW Flag that marks that all OEM Fuses have been

FUSE_FILE_GLOBAL_VALID
programed.

FW SKU flag: marks if Firmware TPM is enabled in

FUSE_FILE_TPM_DISABLE the Platform.

4.1 FPF Mirroring

4.1.1 Motivation

FPF mirroring allows validation\testing of FPF on the FW level, as oppose to
manufacturing phase, where the FPF’s are HW fused.

FPF mirroring is done via FPF configuration file.
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4.1.2

FPF Mirroring in FITC

intel.

1. Edit the FPF configuration file according to the required features. (default matches
platform POR)
2. Fill in the Intel TXE region in FITC, as described in section 3.4.1.

3. Double click on Intel FPF Mirroring File in
TXE Region->Configuration->TXE and navigate to the edited FPF configuration

file,

as depicted.

Figure 21. FPF Mirroring in FITC
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5 Intel® TXE Secure Boot
Manifest Generation Tool
(FLAMINGO Tool)

Intel® TXE Secure Boot Manifest is used to authenticate the BIOS Initial Boot Block
(IBB) and KEY MANIFEST

Key Manifest authenticates the key sued to sign the Intel TXE Secure Boot Manifest.
Key Manifest is optional.

Intel recommended method is Key Manifest

5.1 FLAMInGo Tool Parameters
Table 2. Parameters
Parameter Name Description

PublicKeyFile Public key file to calculate Sha256 from

HashFileout Name of the file to place the SHA256 digest of the
public key

FuseConfigFile Name of the file that contains the fuses configuration

ManifestName String that identifies the manifest, same name must
be used when completing the manifest generation

IBBFile Name of the file that contains IBB data (maximum
127kb)

SVN Security Version Number

SigningKey Name of the file that contains the public key of the
key that is used to sign the manifest

OEMDataFile Name of the file that contains OEM data (maximum
400 bytes)

KeyManifestFile Name of the file that contains a valid key manifest

generated by this

SignatureFile Name of the file that contains an RSA signature of
the hash file generated when creating a manifest

Unsigned Creates the blob of the manifest without generating a
hash (optional)

e For further information type "FLAMINGO.exe ?”
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5.2

Creating Secure Boot Manifest & Signhing IBB

This section will cover creating and signing of the SB manifest which is required to
enable verified boot.

Prerequisites:

e Public and private key to be used for signing the BIOS
e FLAMIinGo tool (can be found in the FW kit)

e SampleSigner (can be found in the FW kit )

e FPFconfigFile.txt (can be found the FW Kit)

e IBB (127KB) - Initial Boot Block

Creation and Signing Procedure

1. Open CMD and use Flamingo to hash the certificate:
FLAMINnGO.exe HashKey pubkey.cer PubKeyHash.txt
the output will be the PubKeyHash.txt which will include the hash of the public
key.

2. Insert the hash of the public key from the previous step into the FPFconfigFile.txt
under FUSE_FILE_OEM_KEY_HASH_1,
and enable secure boot by setting the FUSE_FILE_SECURE_BOOT_EN value to 01.
the result should look like this (with your own hash key inside):

Figure 22. FPFconfigFile.txt Example

Bring Up Guide

#This Fuse bit is for enabling Verified Boot. Change value to "81" to enable Secure/verified boot
FUSE_FILE_SECURE_BOOT_EN:@1:FALSE

#Hash of the public part of the OEM signing key obtained with the Flamingo tool
FUSE_FILE_OEM_KEY_HASH_ 1:1234321123213543213543213543188735135135134621364354354135643413 : FALSE

#The 13 Most Significant Bits of address of alternate copy of IBB within BIOS region
#A1t_bios_limit file is 16 bits wide; applicable values are up to Bx1FFF (13 bits effective).
FUSE_FILE_ALT_BIOS_LIMIT:@eee:FALSE

#This is the ID of the of the Key Manifest ('@' indicates no key manifest is required)
FUSE_FILE_KEY_MANIFEST_ID:@@:FALSE

3. Use Flamingo to create the Secure Boot manifest
FLAMInGo.exe SBManCreate [FuseConfigFile] [Manifest Name] [IBBFile]
[SVN][Signing Key] [-OEMDataFile <OEMDataFile>]
The output will be the hash of the Secure Boot manifest and an .xml structure file
with the name [Manifest Name]

4. Sign the Hash of the Secure Boot Manifest using sampleSigner:
SampleSigner.exe [HashFileToSign] [PrivateKeyFile] [OutSignatureFile]
The output will be the signature file.
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5.3

5. Complete the process by integrating the Secure Boot manifest with the IBB
FLAMInGo.exe SBManComplete [FuseConfigFile] [Manifest Name]
[Signature File]

The output here will be a 128KB .bin file which will includes the Secure Boot
manifest (1KB) and the IBB (rest of the 127KB)

6. Copy the 128KB file to the end of the BIOS or the full SPI image.

Sample run of the tools:

FLAMINGO.exe HashKey pubkey.cer PubKeyHash.txt

FLAMInGO.exe SBManCreate FuseConfigFile.txt manifest IBB.bin 2 pubkey.cer -oemdatafile
oemdata.bin

SampleSigner.exe manifest_SB_hash.bin pubkey.cer manifest_sig.bin

FLAMINGO.exe SBManComplete FuseConfigFile.txt manifest manifest_sig.bin

Creating Key Manifest & Signing IBB

This section will cover creating and signing of the Key manifest which is required to
perform verified boot using Key Manifest.

Prerequisites:

e Create two Public and private key sets and a certificate from each pair, one for the
Key manifest (e.g KMpubkey) and one for the secure boot manifest (e.g SBpubkey).

e FLAMinGo tool (can be found in the FW kit)
e SampleSigner (can be found in the FW kit)
e FPFconfigFile.txt (can be found the FW Kit)
o IBB (127KB)

Creation and Signing Procedure

1. Use Flamingo to hash the Key Manifest certificate:
FLAMINnGO.exe HashKey KMpubkey.cer KMPubKeyHash.txt
the output will be the KMPubKeyHash.txt which will include the hash of the public
key of the Key Manifest.

2. In the FPFconfigFile.txt file:

e Insert the hash of the Key Manifest public key from the previous section under
FUSE_FILE_OEM_KEY_HASH_1

e Enable secure boot by setting the FUSE_FILE_SECURE_BOOT_EN value to 01

e Set the Key Manifest ID under FUSE_FILE_KEY_MANIFEST_ID, note that the Key
Manifest ID should be different form 00.

e The result should look like this (with your own hash key and Key Manifest ID
inside):
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Figure 23.

FPFconfigFile.txt Example

|
#This Fuse bit is for enabling Verified Boot. Change value to "B1" to enable Secure/werified boot
FUSE_FILE_SECURE_BOOT_EN:@1:FALSE

#Hash of the public part of the OEM signing key obtained with the Flamingo tool
FUSE_FILE_OEM KEY_HASH 1:1234321123213543213543213543188735135135134621364354354135643413: FALSE

#The 13 Most Significant Bits of address of alternate copy of IBBE within BIOS region
#A1t_bios_limit file is 16 bits wide; applicable values are up to Bx1FFF (13 bits effective).
FUSE_FILE_ALT_BIOS_LIMIT:@@88:FALSE

#This is the ID of the of the Key Manifest (@' indicates no key manifest is required)
FUSE_FILE_KEY_MANIFEST_ID:aihFALSE

3. Use Flamingo to generate the hash of the Key Manifest:
FLAMInGo.exe KeyManCreate [FuseConfigFile] [ManifestName][KeyToCerify]
[SVN] [SigningKey]

o KeyToCertify is the the certificate of the Secure Boot Manifest to be used (e.g
SBpubkey)

e SVN will be set to 0 for testing (this is relevant for Key revocation)

e SigningKey is the certificate of the Key Manifest

4. Sign the hash using SampleSigner
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SampleSigner.exe [HashFileToSign] [KMPrivateKeyFile]
[OutSignatureFile]
the output will be the signature file.

5. Complete the creation of the Key Manifest
FLAMInGo.exe KeyManComplete [FuseConfigFile] [ManifestName] [SignatureFile]

e With this step giving the Key Manifest, the next step is to create the Secure Boot
Manifest (using the Key Manifest in the process).

6. Create the Secure Boot Manifest (the OEM data file is optional)
FLAMINnGo.exe SBManCreate [FuseConfigFile] [Manifest Name] [IBBFile]
[SVN][Signing Key] [-OEMDataFile <OEMDataFile>][-KeyManifestFile
<KeyManifestFile>]

e The FuseConfigFile (FPFconfigFile.txt file) is the original one from the Key Manifest
creating

e SVN will be set to 0 for testing
¢ The KeyManifestFile is the output of step 5
e The output of this section is the hash of the Secure Boot Manifest

7. Sign the hash using sample signer
SampleSigner.exe [HashFileToSign] [PrivateKeyFile] [OutSignatureFile]

e The output of this step is the signature file ([OutSignatureFile]).

8. Complete the process by integrating the Secure Boot Manifest, the Key Manifest
and the IBB
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FLAMInGo.exe SBManComplete [FuseConfigFile] [Manifest Name]
[Signature File]

e The FuseConfigFile (FPFconfigFile.txt file) here is the original one used in the
creation of the Key Manifest.

e The output from this step is a 132KB file that includes the Key Manifest [4KB], the
Secure Boot Manifest [1KB] and the IBB [127KB].

9. Copy the 132KB file to the end of the BIOS or the full SPI image.

5.4 How to Confirm Verified Boot Executed
Successfully

1. From the EFI shell run “PCI 1A 0”

a. Verify offset 50h shows “5C": verified boot executed using mirroring, if not
executed the value will be “00”.

. When enabling verified boot using fused silicon, the value of offset
50h will be “41".

PCI Segment 00 Bus 00 Device 1A Func 00 [EFI 00001A0000]
00000000: 86 80 18 OF 06 01 10 00-0A 00 80 10 00 00 00 00
00000010: 00 00 SO 90 00 00 40 90-00 00 00 00 00 00 00 00
00000020: 00 00 00 00 00 00 00 00-00 00 00 00 86 80 70 72 *

00000030: 00 00 00 00 80 00 00 00-00 00 00 00 FF 01 00 00 ™. ....evevsnnannn

* %%
°
=]

L 2R BB BB 2

00000040: D35 00 00 1F 00 40 00 80-00 00 00 69 00 00 00 00
00000050: 00 F8 3e Q4 01 00 00-00 00 00 00 00 00 00 00
00000060: U0 00 00 10j01} 00 00 00-00 00 00 00 00 00 00 00
00000070: 00 00 00 00 UU 00 00 00-00 00 00 00 00 00 00 00
00000080: 01 A0 03 48 08 00 00 00-00 00 00 00 00 00 00 00
00000090: 00 00 00 00 00 00 00 00-00 00 00 00 00 00 00 00
000000A0: 05 00 00 00 00 00 00 00-00 00 00 00 00 00 00 00
00000080: 00 00 00 CO 02 00 00 00-00 00 00 00 00 00 00 00
000000C0: 09 10 00 00 00 00 00 7F-00 00 00 O1 00 00 00 00
00000000: 08 30 00 00 00 00 00 00-00 00 00 00 00 00 00 00
000000E0: 00 00 00 00 00 00 00 00-00 00 00 00 00 00 00 00 ™.......ovvvuunns
000000F0: 00 00 00 00 00 00 00 00-1A OF OA 01 00 00 00 00 ™......cvvvnnnnns

................

2 % 5 % % % 5 0 RS RECDR
2 % %0 % 28D %S S DS

b. Run: *MEM FFFEO000 -b”

. Verify at this offset in memory that IBB is shielded from the user
(had been copied to the SRAM) as shown below.
If verified boot had not been executed, the IBB will be exposed in this

offset.
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Figure 24. Verified Boot Enabled - IBB is shielded from User
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Figure 25. Verified Boot had Not Been Executed - IBB is visible

Bring Up Guide

FFFE0010:
FFFE0020:
FFFE0030:
FFFEQ040:
FFFEQO50:
FFFEQ060:
FFFEQ070:
FFFEQO080:
FFFEQ090:
FFFEOOAO:

FEFEOODO :
FFFEOQOQOEO:

............

83 %, s {7 (8 w
EA *. qQi.&U....... "
00 EoXiicieieiareinin e aie:s o w
O R T m e o AT 9 PR =
8L Wohaiius SFuDb. . *
00 *QS5HO..U..aB..... w
89 ¥ooee WEeeZi@ oaia®
5 R P R | R B N\
36 N Ve BBAY_X6*
00 *4_R_V65.31...... L
-

----------------

Intel Confidential

27



u ®
l n tel ) Sample Signer —Verified Boot Manifest Signing Reference Tool

6 Sample Signer -Verified Boot
Manifest Sighing Reference
Tool

Signing reference tool can be found under \\Flash Manifest Generation Tool
\SampleSigner.exe.

Parameters:

1. Hash file to sign

2. Private key

3. The output location of the signed file.

Figure 26. Signing Tool

a-l Manifest File Signing W e - =Ml x4 |

Manifest File Signing

Hash File Browse...

Private Key Browse...

Output Browse...

‘ Sign ‘
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7 Widevine* KeyBox Provisioning
Procedure

For full manufacturing flow details, please refer to "Bay Trail M/D Platform,
Manufacturing Recommendation for Intel® Trusted Execution Engine (Intel® TXE) 1.1
SKU Firmware for SR’14 UEFI Android Platform " Document (IBL# 541110)

1. Provision Widevine using IV (Initialization Vector) and encrypted KeyBox file (refer
to 15 for files creation procedure)
- Run FPT -provkb <iv_and_keybox.bin>

...\Flash_Programming_Tool\Windows>fptw.exe -provkb iv_and_keybox.bin

Intel (R) Flash Programming Tool. Version: 1.8.2.1871
Copyright (c) 20e7 - 213, Intel Corporation. All rights reserved.

Platform: Intel(R) Mainstream Express Chipset
Reading HSFSTS register... Flash Descriptor: Valid

--- Flash Devices Found ---
W25Q64BV ID:exEF4017 Size: 8192KB (65536Kb)

2. Optional: Verify that the Widevine device has been properly provisioned
- Run TXEInfo -feat "keybox"

.. .\TXEInfo\Windows>TXEInfoWin.exe -feat “keybox”

Intel(R) TXEInfo Version: 1.0.2.1871

Copyright(C) 20e5 - 2013, Intel Corporation. All rights reserved.

Keybox: Provisioned
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3.  After properly closing manufacturing (using FPT-closemnf), run TXEManuf EOL
Testing.
Edit TXEManuf.cfg file in EOL section
- Uncomment "SubTestName "Validate Keybox Provisioning"" test in order to
include WV Provisioning Test check

SubTestHName="TXE Manufacturing Mode =tatus"
SubTestHName="Flash Region Access Permissions"
SubTestName="CF3GR lock check"

SubTestName="FPF Global Valid bit check"

// SubTestName="Security Descriptor Override (5D0) check"
SubTestName="Validate Keybox Provisioning™

- Run TXEManuf -EOL

... \TXEManuf\Windows>TXEManufWin.exe -EOL

Intel(R) TXEManuf Version: 1.0.2.1071

Copyright(C) 2@@5 - 2013, Intel Corporation. All rights reserved.
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8 Intel® Trusted Execution
Engine Interface (Intel® TXEI)
Driver

Note: Installing Intel® TXEI driver is relevant only if you use Windows OS. For Android OS,
TXEI driver is already part of OS image.

8.1 Install the Intel® TXEI Driver using Installer

1.  Navigate to the root folder of the Intel TXE Installer (\\Installers)

2. Double click “SetupTXE.exe”

3. Follow the installation procedure as shown in Figure 27. Intel® TXE Installation
Steps.
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intel.

Intel® Trusted Execution Engine Interface (Intel® TXEI) Driver

Figure 27. Intel® TXE Installation Steps

Intek® Trusted Exe

You are about to nstal the following product:
Inte}® Trusted Execution Engne

Itis strongly that you exit

i Execution Engine

INTEL SOFTWARE LICENSE AGREEMENT (Alpha / Beta, Organizational Use)
IMPORTANT - READ BEFORE COPYING, INSTALLING OR USING.

Domtme«bed&-sommmmmmdmaw(cohmdy ume')

before continuing. untl you have carefully read the following terms and conditions. By kading or using

ssted Exec

- Inted® Trusted Execution Engne

Chck Next to contnue, or chdk Cancel to exit the setup program.

You are about to nstall the following components:

me.mw«mumﬁmwml lfvoudonotnmmsoewee,denel
nstal or use the

The Software contains preselease “aipha” o Deta” code, which may not be fully functional
nd which Intel Corporation (TIntel") may substantialy modify in producng any “final” version
of the Software. Intel can provide no assurance that it will ever produce or make generally
avalable a “final” version of this Software.

LICENSE. This Software is bcensed for use only In conjunction with Intel component products.
Use of the Software in conjunction with non-Intel component products is not icensed
hereunder. You may copy the Software onto your organization's computers for your

Trusted Execution Engine

Please wait whie the product is being instalied.

< fiack Mext > Cancel

*fou have successfully installed the following product:

Intel® Trusted Execution Engine

Click here to open log fle lacation.

Intel Corporation
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8.2

Install the Intel® TXEI Driver using Command

Line

Please use this option as an alternative method. Installing the driver via Installer is
the recommended method.

1. 1. Verify Intel TXEI driver is not installed on your system by:

a.

b.
C.
d

Open Device Manager (right click on My Computer -> Manage)
Go to Device Manager subcategory
Open System devices subcategory
Look for device called "PCI Encryption/ Decryption Controller".

If “Intel® Trusted Execution Engine Interface” is already installed, uninstall it by right
click->uninstall and check the "Delete the driver software for this device"
checkbox.

2. Open command line with admin privileges and navigate to the root folder of
TXEi.inf (\\TXEI_Driver\x64 or x86)

3. Type “pnputil.exe -i —a TXEL.inf

Figure 28. Intel® TXEI Installation

B Administrator: CA\Windows\system32\cmd.exe - pnputil -i -a TXELInf = =] “

C:sUsers~AdminsDesktop TXEl_Driversx64>pnputil —i —a TREI.inf
Microsoft PnP Utility

Processing inf : TREI.inf

4. Select “Install”

Figure 29. Windows Security Prompt

Bring Up Guide

Windows Security “

Would you like to install this device software?

; Mame: Intel System devices
:.&‘ Publisher: Intel Corporation - Client Components Gr...

[l Always trust software from "Intel Corporation - Don't Install

Client Components Gr...",

& You should only install driver software from publishers you trust. How can | decide which device software is
safe to install?
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Figure 30. Finishing Intel® TXEI Installation

o Administrator: CAWindows\system32\cmd.exe

sUserssAdminsDesktopsTREI _Driversxb4>pnputil —i —a THEI.inf
icrosoft PnP Utility

Processing inf : TREI .inf

Successfully installed the driver on a device on the system.
Driver package added successfully.

Published name : oen?.inf

otal attempted:
umber successfully imported: 1

sUserssAdminsDesktophTREI _Driversxb4>pnputil —i —a THEI.inf

5. Verify Intel® TXEI is installed by referring to device manager->System
devices:

Figure 31. Verify Intel® TXEI Installation in Device Manager

4 M Systern devices
M ACPI Fan
ACPI Fixed Feature Button
ACPI Lid
ACP| Power Button
ACPI Sleep Button
ACPI Thermal Zone
Compuosite Bus Enumerator
High Definition Audic Controller
High precision event tirmer
Intel(R) 82802 Firmware Hub Device
Intel(R) Trusted Execution Engine Interface
Microsoft ACPI-Compliant Embedded Controller
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9 Using WIinPE Tools

When using Windows FW tools in WinPE, please remember to load the TXEI driver at

every boot.
This can be done by: X:\Windows\System32>drvload.exe <path>\TXEL.inf.

TXEL.inf can be found in every FW kit release.
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10 Using EFI System Tools in UEFI
Shell with UEFI Secure Boot
Enabled Option

Due to Microsoft’s mandatory UEFI Shells and related applications requirement
(System.Fundamentals.Firmware.UEFISecureBoot), when running Intel or customer
manufacturing utilities in UEFI shell, customer is required to disable UEFI Secure boot
via BIOS setup menu or UEFI variable. If OEM/ODM wants to run specific EFI tool that
need to run with UEFI secure boot, OEM/ODM will sign that EFI tool with their OEM
key.
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11

Intel TXEManuf

11.1

11.2

Bring Up Guide

Intel TXEManuf tool will auto-detect the hardware/firmware SKU, and automatically
runs tests to check functionality of their related features on the manufacturing line.
Prerequisites

Intel® TXEI driver must be installed. (Please refer to section Note: for instructions on
how to install Intel® TXEI driver).

TXEManuf Usage

For detailed instructions please refer to “Intel TXEManuf” section in “System Tools User
Guide” document, located at the System Tools folder.
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12 Intel® TXE FW Update

Intel FWUpdate tool allows an end user, such as an IT administrator, to update Intel
TXE FW without having to reprogram the entire flash device. It then verifies that the
update was successful.

12.1 Prerequisites

Intel® TXEI driver must be installed. (Please refer to section 8 for instructions on how
to install Intel® TXEI driver).

12.2 FWUpdate Usage

For detailed instructions please refer to “Intel TXE FW Update” section in “System Tools
User Guide” document, located at the root folder.

38 Intel Confidential Bring Up Guide



Intel® System Scope Tool (Intel® SST)

13

(Intel® SST)

Intel® System Scope Tool

The Intel® System Scope Tool (Intel® SST) is a tool which gives the complete
snapshot of the system including both hardware and the software details.

Figure 32. Intel® System Scope Tool Screen Shot

Intel® System Scope Tool (Intel® SST)

¥ Sove @BPCe T Software M System & Settings () Help

=4 System Information

£8 _|Processor
& MsSR

=+ Memory
« E820
=+« SPD Data
- A4
* AC
- &3 SMBIOS
& Fumware Version Inf
- &3 Plaform Responsivene
28 FPDT
8 FPDT DUMP
# Gidnformation
= » PCH
« SP! Information
+ Battery Information
© ACPI

Processor Information

Key
Genuine Intel(R) CPU 0000 @ 200GHz

@ Name

@ Address Width

@ Architecture

@ Current Clock Speed

@ Data Width

o Descrption

@ Device ID

@ Manufacturer

@ Maumum Clock Speed

) Processor ID

@ Processor Type

@ Role

) Microcode Version
Topology Details

£ Number of Physical Processor Packages

Value

Genuine Intel(R) CPU 0000 @ 2 00GHz
64 bits

x4

2100 MHz

64 bits

intel64 Family 6 Model 60 Stepping 2
CPUO

Genuinelinte!

2100 MHz

BFEBFBFF000306C2

Central Processor

CPU

OXFFFF0006

e This tool is useful for providing full platform information for debugging

purposes.

e An output file can be saved in .html format and attached to Bay Trail sightings
e This tool can be found on Intel® VIP inside the Bay Trail-M/D Compliance Kits
(PV VIP kit # 54724).
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14 FITC Soft Straps

Table 3. SOC Strap 0

Location Parameter Values Description
BIOS 0x0000 Specifies the lower base of the BIOS
- Flazh I
= E as r'na.ge ) Protected protected range number 4. Address
(-3 Descriptor Region Range 4 bits [11:0] are assumed to be
..... [ Descriptor Map Base 12'h000 for the base comparison.

(goes to bits [12:0] at register:

""" (3 Component Section [Protected_Range_4] PR4 (@0x84)).

-0 Master Access Section

=53 SOC Straps BIOS 0x0000 Specifies the upper limit of the BIOS
: Protected protected range number 4. Address
""" 8} SOC Strap 0 Range 4 bits [11:0] are assumed to be
----- [C3 SOC Strap 2 Limit 12'hFFF for the limit comparison.
_____ (g soc Strap 3 (Goes to bits [28:16] at register:

[Protected_Range_4] PR4 (@0x84)).

----- [C SOC Strap 4

..... [ S50C Strap 5 BIOS True When set, Fhi'_s b_it indicates t_hat the
Protected False Base and Limit fields are valid and
""" (3 SOC Strap 7 Range 4 (default) | that writes directed to addresses
..... |:| SOC Strap 8 Write between them (inclusive) must be
Protection blocked by hardware. The base and
""" 4 Upper Map Enable limit fields are ignored when this bit
-1 VSCC Table is cleared. Disabling this protected
..... ([ OEM Secticn range could be done also by the
_____ B¢ PDR Region security override pin strap. (this soft
) strap and the security override pin
""" m GbE Region strap are reflected into bit 31 at
..... (3 TXE Region register: [Protected_Range_4] PR4
..... (13 BIOS Region (@0x84)).
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Table 4. SOC Strap 2

intel.

True

Location Parameter Values Description
23 Flash1 SPI Boot 00: 64KB (Default): Sets SPI Boot Block Size
83 D Block Size Invert A16 if Top Swap
(=<3 Descriptor Region is enabled.
() Descriptor Map 01: 128KB: Invert A17
(3 Component Section if Top Swap is enabled.
- . 10: 256KB: Invert A18
|
[+ f.] Master Access Section if Top Swap is enabled
=43 SOC Straps
- SIO1_FO_Di False (default) Disable LPSS1 function
_L] SOC Strap 0 sable True 0 (DMA). false =
g enable. true = disable
3 50C Strap 3 SIO1_F1_Di | False (default) Disable LPSS1 function
(3 SOC Strap 4 sable True 1 (PWM#1). false =
() SOC Strap 5 enable. true = disable
(1 SOC Strap 7 SIO1_F2_Di | False (default) Disable LPSS1 function
(3 SOC Strap 8 sable True 2 (PWM#2). false =
= enable. true = disable
(3 Upper Map
@-(3 VSCC Table SIO1_F3_Di False (default) Disable LPSS1 function
- ) sable True 3 (HSUART#1). false =
(3 OEM Section enable. true = disable
) PDR Region _ : .
4 SIO1_F4_Di False (default) Disable LPSS1 function
) GbE Region sable True 4 (HSUART#2). false =
() TXE Region enable. true = disable
(3 BIOS Region SIO1_F5_Di | False (default) Disable LPSS1 function
sable True 5 (SPI). false = enable.
true = disable
SCC SDIO False (default) Disable SDIO. false =
Disable True enable. true = disable
SCC False (default) Disable SDCARD. false
SDCARD True = enable. true = disable
Disable
HAD Disable | False (default) Disable HD Audio. false
True = enable. true = disable
LPE Disable False (default) Disable LPE. false =
True enable. true = disable
XHCI False (default) Disable USH. false =
Disable True enable. true = disable
LAN Disable | True (default) Disable GbE. False =
False enable. true = disable
SATA False (default) Disable SATA. False =
Disable True enable. true = disable
EHCI False (default) Disable USB: false =
Disable enable, true = disable
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FITC Soft Straps

True

Location Parameter Values Description
PCIe 0 False (default) Disable PCIe port 0.
Disable True False = enable. true =
disable
=43 Flash Image PCle 1 False (default) Disable PCIe port 1.
: . . Disable True False = enable. true =
B3 DESCFIFItD.r Region disable
----- [C0 Descriptor Map
- PCIe 2 False (default) Disable PCIe port 2.
----- L3 Component Section )
) Disable True False = enable. true =
-0 Master Access Section disable
Ela SOC Straps PCle 3 False (default) Disable PCle port 0.
. (3 SOC Strap 0 Disable True False = enable. true =
i | SOC Strap 2 disable
[0 50C Strap 3 SI02 FO False (default) Disable LPSS2 function
tee 2 SOC Strap 4 Disable True 0 (I2C#0). false =
_____ (3 Upper Map enable. true = disable
-2 VSCC Table SI02 F1 False (default) Disable LPSS2 function
_____ (3 OEM Section Disable True 1 (I2C#1). false =
. enable. true = disable
----- (%} PR Region
_____ (1 GbE Region SI02 F2 False (default) Disable LPSS2 function
. Disable True 2 (I2C#2). false =
""" (3 TXE Regien enable. true = disable
----- [Z3 BIOS Region
SIO2 F3 False (default) Disable LPSS2 function
Disable True 3 (I2C#3). false =
enable. true = disable
SI02 F4 False (default) Disable LPSS2 function
Disable True 4 (I12C#4). false =
enable. true = disable
SI02 F5 False (default) Disable LPSS2 function
Disable 5 (I2C#5). false =

enable. true = disable
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Table 5. SOC Strap 3

Location Parameter Values Description
=23 Flash Image ! SIO2 F6 Disable False Disable LPSS2 function 6
; . . (default) (I2C#6). false = enable.
-2 Descriptor Region True true = disable
----- [ Descriptor Map
_____ (1 Component Section SIO2 F7 Disable False Disable LPSS2 function 7
. (default) (I2C#7). false = enable.
Eg zﬂ;ét; Access Section True true = disable
—]- raps
_____ DISBENDCLK_SSEN False Enable spread spectrum to
03 S0C Strap 0 (default) DISPLAY BEND: false =
""" (3 SOC Strap 2 True disable, true = enable
----- B8] SOC Strap 3
DISPSSCLK_SSEN False Enable spread spectrum to
""" &0 SOC Strap 4 (default) DISPLAY SS: false =
----- (3 SOC Strap 5 True disable, true = enable
----- 3 50C Strap 7
SOC S P 8 HFHPLLCLK_SSEN False Enable spread spectrum to
""" ] trap (default) HFHPLL: false = disable,
----- [ Upper Map True true = enable
m- L VSCC Table
. PCIECLK_SSEN False Enable spread spectrum to
""" (3 OEM Section (default) PCle: false = disable, true
----- [ PDR Region True = enable
""" | alse nable spread spectrum to
(26 GbE Region SATACLK_SSEN Fal Enabl d
----- [0 TXE Region (default) SATA: false = disable, true
..... D BIOS Regign True = enable
| | OTG Super Speed False Disable OTG Super Speed
PHY Disable (default) PHY. false = enable. true =
True disable
XHCI Super Speed False Disable USH Super Speed
PHY Disable (default) PHY. false = enable. true =
True disable
Spread Percentage 0.456 Select Spread Spectrum
(default) Percentage (%). 0.456 is
0.439 the Intel recommended
42 value. Other values are for
0.423 testing purposes only.
0.391
and more...
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Table 6. SOC Strap 4

FITC Soft Straps

----- [ Descriptor Map
----- (3 Component Section
-0 Master Access Section

-5 SOC Straps

L SOC Strap 0
[C3 SOC Strap 2
[C SOC Strap 3
B] SOC Strap 4
L SOC Strap 5
[C3 SOC Strap 7
[C SOC Strap 8

----- [ Upper Map

-1 VSCC Table

----- L OEM Section
----- [ PDR Region

----- (X GbE Region

----- [ TXE Region

----- [C1 BIOS Region

Location Parameter Values Description
-4 Flash Image LPC GPIO Select 1'b0: LPC Select the usage of
: . . (default) LPC pins
-2 Descriptor Region 1'b1: GPIO

LPCCLK1_enb

True (default)
False

False = disable. true
= enable

LPCCLK_SLC

1'b0 - iLPCCLKO
(default)

1'b1 - iLPCCLK1

Select LPC return
clock source. This
soft-strap is reflected
to LPCC.LPCCLK_SLC
register

DELAY_PCIE_RLS

False (default)
True

Note: Not
configurable
strap. Value
automatically
set according to
PCIECLK_SEEN
value.

When set, PCle reset
release will be
delayed after PMC
patch load. Note: if
PCIECLK_SEEN is
enabled,
DELAY_PCIE_RLS
must be set as 1
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Table 7. SOC Strap 5

(inteD)

----- [X] PDR Regicn

(x1)

10: 2x2 Port 1
----- X GbE Region (x2), Port 3 (x2)
..... [C TXE Region 11: 1x4 Port 1
..... [ BIOS Region (x4)

Note !

Location Parameter Values Description
STGREN 1: Port Set the default for the
Ea Flash Ir'na.ge _ Register Staggering PCI. Port Staggering
-3 Descriptor Region Enabled (default) | Enabled: 0 = No Port
----- [ Descriptor Map 0: No Port Staggering, 1= Port
_____ - Staggering Staggering Enabled.
(3 Component Section
. This strap sets the default
-0 Master Access Section value of the PCIe
=423 SOC Straps PORTSTAGEN register.
""" (3 50C Strap 0 Lane 0: No Lane Lane Reversal: 0 = No
----- [C3 SOC Strap 2 Reversal Reversal Lane Reversal, 1= Lane
..... [C3 SOC Strap 3 (default) Reversal.
_____ (3 50C Strap 4 1: Lane Reversal
----- S0C Strap 5 Root Port 00: 4x1s Port 1 Set the default value of
P
_____ 3 50C Strap 7 Configuration (x1), Port 2 (x1), root Port Configuration.
Port 3 (x1), Port
----- (3 SOC Strap 8 4 (x1) (default)
""" (3 Upper Map 01: 1x2, 2x1s
-3 VSCC Table Port 1 (x2), Port
..... 2 OEM Section 3 (x1), Port 4

Note *: If the ‘Root Port Configuration’ default value is been changed in SOC Strap 5
the following changes need to be performed as well:

If the Value of “"Root Port Configuration” been changed to "01: 1x2, 2 x1s Port 1 (x2),
Port 3 (x1), Port 4 (x1)”
Require change of “"PCIe 1 Disable” value in PCH Strap 2 from “false” to “true”.

If the Value of “"Root Port Configuration” been changed to “10: 2x2 Port 1 (x2), Port 3
(x2)",

Require change of “PCle 1 Disable” and “"PCle 3 Disable” in PCH Strap 2 from “false”
to “true”.

If the Value of “"Root Port Configuration” been changed to “11: 1x4 Port 1 (x4))”,
Require change of “"PCle 1 Disable” and “PCle 2 Disable” as well as “"PCle 3 Disable” in
PCH Strap 2 from “false” to “true”.
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Table 8. SOC Strap 7

FITC Soft Straps

[C1 BIOS Region

Location Parameter Values Description
-3 Flash Image PCIECMNLNPW True (default) False = disable, true =
: i . Enable False enable.
=23 Descriptor Region
----- [ Descriptor Map NOT(I:EI;CkIrLtSeagJ:taeSd
----- (3 Component Section specs must be
B~ C0 Master Access Section 5'9':1‘_’-‘td Otff by SEG
=--£3 SOC Straps architects.
PCIELANEOPWREN | True (default) PCIE Enables power for
""" (2 50C Strap 0 False digital (synthesized)
----- ra ogic for the Common
L SOC Strap 2 logic for the C
_____ (1 SOC Strap 3 Lane logic and F_’LLlCore
uPAR: false = disable,
""" (3 SOC Strap 4 true = enable.
""" — SOC Strap 5 PCIELANEIPWREN | True (default) | PCIE Enables power for
----- B8] SOC Strap 7 False digital (synthesized)
..... [ 50C Strap 8 logic in the data lane to
_____ 3 Upper Map reduce leakage.
-2 VSEC Takble PCIELANE2PWREN | True (default) PCIE Enables power for
_____ . False digital (synthesized)
a GEM.Sectmn logic in the data lane to
----- [ PDR Region reduce leakage.
""" (2%} GbE Region PCIELANE3PWREN | True (default) | PCIE Enables power for
----- [ TXE Region False digital (synthesized)

logic in the data lane to
reduce leakage.
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Table 9. SOC Strap 8
Location Parameter Values Description
-3 Flash Image SATACMNLNPW True False = disable, true =
Elﬁ Descriptor Region Enable (default) enable.
..... D Descriptgr Map False NOTE: Integrated
_____ C t Secti clock usage and
L3 Component Sec |c|r.'| specs must be
-[C1 Master Access Section signed off by SEG
B3 SOC Straps architects.
--[Z1 SOC Strap 0 SATALANEOPWREN | True SATA Enables power
[0 50C Strap 2 (default) for digital
(13 50C Strap 3 False (synthesized) logic for
the Common Lane
~-(2 50C Strap 4 logic and PLL1Core
-] SOC Strap 5 UPAR: false = disable,
- SOC Strap 7 true = enable.
R e SATALANE1PWREN | True SATA Enables power
----- (3 Upper Map (default) for digital
E-C0 VSCC Table False (synthesized) logic in
..... (L3 OEM Section the data lane to
_____ ) PDR Region reduce leakage.
----- (%] GbE Region Satastatus2PMC True False = SATA to
..... ([ TXE Region (default) indicate D3 status to
_____ (7 BIOS Region False PMC True = SATA to
indicate DEVSLP
status to PMC.
§
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15 Appendix A: Google*
Widevine* for Intel® TXE

15.1 Creating Widevine* CEK (Customer Encryption
Key)

The CEK is responsible for encrypting Widevine Keybox in Android devices and not
accessible by the host. The CEK is a global key used among the same models of
devices for a single Customer.

Note: The below key files are for demonstration purposes only and are not actual keys.

15.1.1 FITC CEK File Creation Procedure

15.1.1.1 Cleartext CEK
1. Generate a 16-byte Hex random number (unique per OEM) which is called
CEK.
2. Combine 240 bytes of 0xFF (upper) with 16-byte CEK (lower) into 256 bytes
FITC_CEK.bin
3. Insert FITC_CEK.bin into flash image with FITC tool (refer to section 3.4.1
steps 6 and 7).

Figure 33. FITC CEK File Map Example

W[ 5 FTC_CEKbin X

00000184 00 01 02 03

(=
B

05 06 07 08 09 Oa Ob Oc 0d Oe Of

00000050 | ££ £f
00000060 | ££f £f
00000070 | ££ ££

ff f£f ff ff ff
ff L ff L it
ff ff ff ff ff

00000000 £ff £ff £f ff ff £f £f £f f£f ff ff £ff ff ff ff ff ™=
00000010 £ff £f £f ff f£f £f £f £f £f £ff £f £f f£f £ff ff ff
00000020 £ff £ff £ ff ff ff ff £
00000030 £ff £f £f ff f£f £ff £f £f
00000040 £f £f ff ff f£f ff ff ff

£

"

"™
-

.. 240-bytes of O0xFF

00000080 | ££ £2 £2 £2 £f £f ff ££2  £f 2

00000090 | ££f ££f £f £f f££ ££ ff £F  £f £f

000000a0 | £F £F £f £f £f £f £f £f £f £f

000000b0 | ££ £2 £f ££ £f £f ££f £ £f £f

000000cO | ££ £f £f ££ £f ££ ££f £ £f £

000000d0 | ££ ££ £ ££ ££ ££ ££ ££  ££ £

000000e0 | £f £f £f £f £f £f ff £f ff £f £f £f £f £f £f £f _J

000000£0 | cl 87 1d 57 65 92 49 36 3a b7 c9 8d 6e 0f di £0 €— 16-bytes of CEK

When building the image, add FITC_CEK.bin file (Flash Image -> TXE Region -
> Configuration -> TXE -> CEK Configuration)
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15.1.1.2

Bring Up Guide

Ciphertext CEK

intel.

Note: Customer should scope relevant Google* documentation and decide for CEK

insertion method. Intel recommended method is ciphertext

1. Generate a 16-byte Hex random number (unique per OEM) which is called CEK.
2. Create concatenated CEK||subjectname into one file (cek_sn.bin)

a. SubjectName can be found under \\System
Tools\Certificates\TXE1SubjectName.bin

:I | 7] cek_sn.bin x]

000000eb 00 01 02 03 04 05 06 07 08 09 Oa Ob Oc 0d Oe Of
00000000 30 11 Oc 33 44 55 6e 77 88 30 aa Oc cc dd 30
00000010 30 81 84 31 16 30 14 06 03 55 04 03 Oc 0d 77 77
00000020 77 2e €9 6e 74 65 6c 2e 63 6f 6d 31 1le 30 1c 06
00000030 03 55 04 0Ob Oc 15 57 €9 64 65 76 69 ¢6e 65 20 6b
00000040 65 79 62 6£f 78 20 6£f 77 6e 65 72 31 1a 30 18 06
00000050 03 55 04 0a Oc 11 49 6e 74 65 6c 20 43 €f 72 70
00000060 6f 72 €1 74 69 6f 6e 31 14 30 12 06 03 55 04 07
00000070 Oc Ob 53 61 6e 74 61 20 43 6c 61 72 61 31 0Ob 30
00000080 09 06 03 55 04 08 Oc 02 43 41 31 0Ob 30 09 06 03
00000090 55 04 06 Oc 02 55 53

o <€—16-bytes of CEK

[ 135-bytes of
SubjectName

3. Use openssl tool (open source tool) to convert the CEK certificate to *.pem format
a. CEK certificate can be found under \\System Tools\Certificates\

TXE1DrmCekKeyProvPreProduction.cer

b. Run openssl.exe x509 -inTXE1DrmCekKeyProvPreProduction.cer -inform DER
-out <TXE1DrmCekKeyProvPreProduction_CEK.pem> -outform PEM

4. Encrypt CEK:

a. Run: openssl.exe rsautl -encrypt -inkey
<TXE1DrmCekKeyProvPreProduction_CEK.pem> -certin -pkcs -in cek_sn.bin
-out en_cek_sn.bin

<> |7 en_cek_sn.bin x|

00000156 | 00 01 02 03 04 05 06 07 08 09 Oa Ob Oc 0d Oe Of
00000000 1b 10 79 13 £8 95 1b 10 79 £2 de 75 e6 12 36 84
00000010 | 07 30 44 cf c5d4 b0 € 37 16 fe bb 2d 81 91 69
00000020 | Oa 1b 10 79 a6 Sc 9f 99 80 93 52 3e d8 bé 92 b0
00000030 | bc 89 1le 78 d4 39 09 44 cf c5 d4 le 78 d4 b0 £fb
00000040 | el £6 12 93 05 c7 db e0 £6 dd 62 fc 61 e0 09 S3
00000050 | ee 3c aa 44 cf cS d4d 1b 10 79 cf c5 d4 9a 69 4f
00000060 | d9 e2 96 df 9d 00 4b 42 1d 35 c3 66 ¢3 83 b3 &d
00000070 | bd O0a dS 44 cf c5 d4 e4 <£fe b7 53 44 cf c5 d4 bf
00000080 | 24 fb c7 £fd Sb ae 3b le 78 d4 18 78 c3 60 05 &f
00000090 | 29 £3 €3 c3 70 e7 44 cf c5d4 07 88 05 d3 3e b9
000000a0 | 84 1f 3e 16 17 cd Sc 1b 10 79 1d 3b 5d a9 dé 29
000000b0 | 40 18 bc 88 1e 78 d4 c8 DbS 73 e6 £f1 80 81 25 6&d
000000c0 | 1b Sd ce e2 £f9 df 44 cf c5d4 a2 29 80 £ff 94 4c
00000040 £bf 44 cf c5d4 dS 6a 7c 62 44 cf c5d4 32 dd
000000e0 | 79 08 2a bS 12 £9 £fc 57 09 b3 d4 c7 cf £3 1c aa
000000£0 | SS 60 1e 1b 10 79 c4 c7 a8 b3 dl 82 08 1f 1le 97

[ 256-bytes of
Encrypted CEK

5. Insert en_cek_sn.bin into flash image with FITC tool (refer to section 3.4.1 steps 6

and 7)
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Appendix A: Google* Widevine* for Intel® TXE

Constructing Widevine* Provisioning KeyBox File

To support Security Level 1 playback of protected content on Android devices,
Widevine Keybox must be provisioned by Customer in factory. This keybox contains a
device ID that is unique for each Android device and is the license that establishes a
root of trust between Widevine DRM servers and the Android device.

15.2.1

KeyBox Creation Procedure

1. Request KeyBox directly from Google.
2. Create appropriate unique 16-byte IV (Initialization Vector) for respective Android

device.

3. Encrypt keybox by global CEK and IV via AES-CBC encryption.

Example of encrypting KB with IV & CEK using AES-CBC:

openssl aes-128-cbc -nopad -K <16-byte-CEK> -iv <16-byte-IV> -in
GoogleKeyBox.bin -out EncryptedKB.bin

4. Write 16 bytes of IV, 128 bytes of encrypted keybox using FPT (refer to Widevine*
KeyBox Provisioning Procedure, Chapter 7)

Figure 34. FPT KeyBox Provisioning File Map Example

ﬂ. | 7] v_and_keybox.bin )(I
0000013¢c 00 01 02 03 04 05 06 07 08 09 0Oa Ob Oc O0d Oe Of
00000000 | 18 d6é ed4 a7 £6 97 84 63 4a 21 64 3¢ 93 £1 26 4d 16-bytes
H Initialization Vector
00000010 | al ec 97 18 1e 80 14 Sc 75 25 ee 1d 82 da be 1c (IV) unique per
00000020 | a5 07 97 £5 b8 50 £7 38 1lc e6 &9 £9 d9 ££f 36 96 Android Device
00000030 | 82 91 4e 4b 67 72 ed 8d bl 4d e9 £7 21 £0 I8 c5
00000040 | 43 24 9d 1a 2a 18 25 2d 53 ae fe 81 £2 cb 17 19
00000050 | el 33 81 0 3b cc a2 46 8a 91 4e 4b &7 72 ed &d -—K%‘;‘)’:‘es Encrypted
00000060 | fd 55 b& df 98 6e a0 £7 el 33 &1 e0 3b cc a2 6a
00000070 | 75 25 ee 14 22 da be 0z d8 1d 3e 97 13 76 4e 4f
00000080 | 8a 91 4e 4b 67 72 ed 8d bl 4d e9 £7 21 £0 £3 c5
8
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Appendix B: Using Local
Android Intel® TXE System
Tools

16.1

16.2

16.3

Bring Up Guide

Using Android System Tools

In order to use TXE System tools locally on SUT, you must push the tools using ADB
(Android Debug Bridge) to a directory that can be accessed using Terminal Emulator
OR using ABD itself.

Setup & Install ADB

Obtain ADB tool (can be attained from Android site). There are Linux and Windows
versions of the tool. Usage of this tool will be the same with respect to TXE System
tools.

How to Push & Use the Intel® TXE System Tools

1. Connect SUT to console
a. Place both SUT & Console on same IP network
b. Use “ADB Connect <IP_Address_Of_SUT>"
2. Push the TXE FW tools & their components, example below:
a. \platform-tools>adb.exe push FPT /data/local
1862 KB/s (357043 bytes in 0.187s)
b. \platform-tools>adb.exe push TXEInfo /data/local
1986 KB/s (222110 bytes in 0.109s)
c. \platform-tools>adb.exe push TXEManuf /data/local
1914 KB/s (305893 bytes in 0.156s)
d. \platform-tools>adb.exe push TXEManuf.cfg /data/local
377 KB/s (6023 bytes in 0.015s)
e. \platform-tools>adb.exe push fparts.txt /data/local
7 KB/s (8057 bytes in 1.000s)
f. \platform-tools>adb.exe push vsccommn.bin /data/local
133 KB/s (2132 bytes in 0.015s)
g. \platform-tools>adb.exe push FpfConfigFile.txt /data/local
26 KB/s (431 bytes in 0.015s)
3. Run the TXE System tools using ADB or local Terminal Emulator
a. Using ABD Example:
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Appendix B: Using Local Android Intel® TXE System Tools

\platform-tools>adb.exe shell

root@android:/ # su

127|root@android:/ # cd data/local

root@android:/data/local # chmod 777 FPT TXEInfo TXEManuf
Verify execution rights have been given via “Is -I”

While in “data/local” directory run: “./TXEInfo” / “./FPT”
“./TXEManuf”

b. Running local Terminal Emulator or Serial connection will be the same usage
of the TXE System tools. For Serial connection on Intel CRB:

Connect microUSB to Console COM port.

Using Terminal client ( i.e. PUTTY) configure connection to be serial
with speed of 115200.

When connection is successful, change to Android directory where
tools have been pushed (i.e. /data/local per above example).
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